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Acronyms
• ALMA Common Software. (ACS)
• Astronomical Unit (AU)
• Command and Data Handling System (C&DH)
• Charge-Coupled Devices (CCDs)
• Communication (Comm)
• Cosmic Ray Effects on Micro-Electronics (CREME)
• Charge Transfer Ratio (CTR)
• Error Eetection and Correction (EDAC)
• Earth radius (ER)
• Galactic Cosmic Rays (GCR)
• Geostationary orbit or Geosynchronous orbit (GEO)
• Geostationary Operational Environmental Satellite 

(GOES)
• Goddard Space Flight Center
• Geostationary transfer orbit (GTO)
• Highly elliptical orbit (HEO)
• Hubble Space Telescope (HST)
• Integration and Test (I&T)
• Institute of Electrical and Electronics Engineers (IEEE)
• stable points in interplanetary space
• Low earth orbit (LEO)
• Linear Energy Transfer (LET)
• Microwave  Anisotropy Probe (MAP)
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• Multiple Bit Upset (MBU)
• Medium earth orbit (MEO)
• National Aeronautics and Space Administration 

(NASA)
• North American Aerospace Defense Command 

(NORAD)
• Nuclear & Plasma Sciences Society (NPSS)
• South Atlantic Anomaly (SAA)
• Solar Anomalous and Magnetospheric Particle 

Explorer (SAMPEX)
• Single Event (SE)
• Single Event Burnout (SEB)
• Single Event Effects (SEEs)
• Single Event Functional Interrupt (SEFI)
• Single Event Gate Rupture (SEGR)
• Single Event Latch-up (SEL)
• Solar Energetic Particles (SEPs)
• Single Event Transient (SET)
• Single Event Upset (SEU)
• Single Event Hard Errors (SHE)
• Solid State Star Tracker (SSST)
• Total Ionizing Dose (TID)
• United States Air Force (USAF)
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Outline

• Space Environments & Effects
• Definitions & Units
• High Energy Radiation Environment

» Solar Protons & Heavier Ions
» Cosmic Ray Ions
» Trapped Protons & Electrons (Van Allen Belts)

• Radiation Hardness Assurance
• Summary
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Space Environments

• Plasma
• Particle Radiation
• Neutral Gas Particles
• Ultraviolet & X-ray
• Micro-meteoroids & Orbital Debris
• Electromagnetic Radiation, Thermal 

Environment, Geomagnetic 
Field,Gravitational Field
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Space Environments & Effects
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Single
Event
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Definitions

• Distance
» Sun to Earth = 1 Astronomical Unit (AU)
» Earth radius (ER) = 6378.165 km at equator

• Spacecraft Orbits
» Inclination – Angle between equatorial plane and orbit 

plane
» Altitude – Distance from earth’s surface in km

• Orbit Altitude
» LEO – Low earth orbit < 1000 km
» MEO – Medium earth orbit 1000 km – 36,000 km
» GEO – Geostationary orbit = 36,000 km or 6.6 - 7.0 ER
» GEO – Geosynchronous orbit
» GTO – Geostationary transfer orbit
» HEO – Highly elliptical orbit
» L1, L2, L3, etc. – stable points in interplanetary space
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Units

Quantity Units Description

Particle Energy, E eV, MeV, GeV Electron volt - the amount of work 
done on an electron when it moves 
through a potential difference of one 
volt

Particle Flux Density, φ # cm-2 s-1 Transfer of particles per unit time 
across a unit area form either side

Particle Fluence, Φ # cm-2 Time rate of particle fluence

Ionizing Dose, D Rads, seiverts The amount of radiation that 
deposits 0.01 joule of energy in 1 kg 
of material

Linear Energy Transfer, 
LET

Fluence/material 
density
MeV cm2 mg-1

dE/dX – mean energy lost by a 
charged particle in electronic 
collisions per unit length of its 
trajectory
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High Energy Radiation

Nikkei Science, Inc. of Japan, by K. Endo

Trapped Particles

Galactic Cosmic Rays

Solar Protons
&

Heavier Ions
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Characteristics of the Radiation 
Environment

• High energies
» Electrons – 10s of MeV
» Protons – 100s of MeV
» Heavier Ions – 1000s of MeV

• Solar variability drives population levels
» Long term solar cycle
» Solar rotation
» Solar storms, magnetospheric storms

• Magnetosphere filters galactic and solar particles
» Polar, low-earth orbits are exposed to interplanetary 

levels during passes over the poles
• Trapped population has complex spatial 

distribution
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Surface Charging
• Induced charge on surface

» Low energy plasma & photoelectric currents
» “Hot” plasma (LEO vs. GEO)

• Orbits with high risk
» LEO – maybe
» MEO - ? probably
» GEO - generally a greater concern
» GTO

• Risk factors
» Geomagnetic substorms resulting in injection of keV 

electrons
» Passage from eclipse to sunlight – positive charge 

surface due to photoelectron emission
» Large spacecraft
» High voltage power system
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Deep Dielectric Charging
• Process

» High energy electrons penetrate into dielectric materials 
(circuit boards and cables).

» Charge builds up and gives rise to intense electric fields.
» When charge exceeds the breakdown potential, discharge 

occurs.
• Missions affected

» Any spacecraft spending long periods in Van Allen belt 
electron regions

» MEO, GEO, GTO, Phasing loops
» Jovian

• Risk factors
» Accumulation of  > 1010 E  > 1 MeV electrons within 10 hours
» Accumulation of  > 3x108 E  > 2 MeV electrons/day for 3 

consecutive days
» Accumulation of  > 109 E  > 2 MeV electrons in a single day
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Displacement Damage Dose (DDD)

• Cumulative long term non-ionizing 
damage

• Effect:
» Production of defects which result in 

charge transfer ratio (CTR) 
degradation

» Optocouplers, solar cells, CCDs, linear 
bipolar devices

• Shielding has some effect
» Solar cell cover glasses and mounting 

panels
» Only for some orbits
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Total Ionizing Dose (TID)

• Cumulative long term ionizing damage
• Strongly dependent on mission duration, orbit, 

and shielding
• Effects

» Threshold Shifts
» Leakage Current
» Timing Skew
» Functional Failures

• Can reduce with shielding
» Low energy protons
» Electrons
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Single Event Effects (SEEs)

• Event caused by a single charged particle
• Effects:

» Non-destructive:  SEU, SET, MBU, SEFI, SHE
» Destructive: SEL, SEGR, SEB

• Severity is dependent on:
» type of effect
» system criticality

• Shielding has little effect
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Solar Activity Cycle

Length varies from 9 - 13 years
Recent solar cycles – 10 years

 Caused by reversal of solar 
magnetic field

 Many indicators of the cycle
- Sunspot count
- F10.7 radio flux
- Atmospheric density

Little Ice Age in 
1645 to 1715

Discovered by Schwab in 1844
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Interplanetary Particles – Galactic 
Cosmic Ray Heavy Ions (GCRs)

• 1913 - Victor Hess’ Balloon experiments
• 1960’s - Light flashes in astronauts’

eyes
• 1975 - Binder et al. documented logic 

upsets on spacecraft
• Properties

» All elements in Periodic Table
» Energies in TeVs
» Found everywhere in interplanetary space
» Omnidirectional
» Filtered by the magnetosphere
» Mostly fully ionized

• Effects
» Astronaut dose
» Single event effects

Victor Hess, 1913
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GCRs:  Nuclear Composition
Energy = 2 GeV/n, Normalized to Silicon = 106
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Solar Cycle Effects: Heavy Ions
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Interplanetary Particles – Solar Energetic 
Particles (SEPs)

• 1946 - Scott Forbush
• Increased levels of protons & 

heavy ions due to SEP events
• Properties

» Protons - 100s of MeV
» Heavy ions - 100s of MeV
» Abundances dependent on radial 

distance from Sun
» Partially ionized
» Number & intensity of events 

increase dramatically during 
“solar active” periods

• Effects
» Degradation
» Single event effects (protons & 

heavy ions)
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Solar Cycle Effects: Solar Protons
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SEPs: Proton Event Spectra
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Trapped Particles

• Cosmic ray detector on 
Explorer I, 31 Jan 1958

» “Zero” levels on 
instrument

• Highlight of US 
participation in IGY

• 1895 - Birkeland theorizes particle 
trapping

• 1904 – Stöermer calculations support 
theory of particle trapping around the 
Earth

• 1958 – James Van Allen
• Properties

» Omnidirectional
» Protons: E ~ 1 keV - 500 MeV
» Electrons: E ~ 1 keV - 10 MeV
» Heavy Ions:  Low E (non-problem for 

electronics)
» Complex distribution based on energy & 

solar conditions
• Effects

» Degradation – protons and electrons
» Single event effects – protons
» Surface charging, Deep dielectric 

charging - electrons
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Proton Drift

Magnetic Field LineElectron Drift

Flux Tube

Trapped Particle Trajectory

Mirror Point

Conjugate Mirror Point

Trapped Particle Motions
Spiral, Bounce, Drift

after Hess
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Trapped Radiation Belts

NASA/LWS Program, Johns Hopkins University Applied Physics Laboratory 

Van Allen Probes Mission
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Trapped Proton Spectra

• Energy range
» .04 - 500 MeV

• Range in Al:
» 30 MeV ~ .17 inch

• Effects:
» Total dose
» Single event 

effects
» Solar cell damage  
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Trapped Electron Spectra

• Energy range
» .04 - 7 MeV

• Range in Al:

• Effects:
» Total dose
» Surface charging
» Deep dielectric 

charging
» Solar cell damage  
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Effect of Solar Storms on Trapped 
Protons – CRRES Measurements

Don Brautigam, AF Phillips Laboratory, SPD/GD, used by permission

March 1991

E = 47 MeV
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Effect of Solar Storms on Trapped 
Electrons – SAMPEX Measurements

• Electron belt changes during Oct 2003 solar storm events
• Daily-averaged particle flux data from the SAMPEX satellite.

2–6 MeV Electrons

D. N. Baker et al.

Threshold = 100 e- Threshold = 1 e-

NASA/Goddard Space Flight Center/Scientific 
Visualization Studio
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Single Event Upsets on Seastar Solid 
State Recorder

• 1SEU • 1<SEU<10 • 10≤SEU<20 • 20≤SEU<40 • ≥ 40 SEU

Protons>10 MeV int. flux>10 p/cm2-s
AP8 max

Harvey Saffron, Orbital Sciences, work performed for NASA GSFC

Orbit: 705 km, 98deg, Duration: 4 years
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Radiation Environment Levels

after LaBel

Moderate: 10-100 krads
Intense single event environment
Moderate displacement damage environment

High:  >100 krads
Intense single event effects environment
Intense displacement damage environment

Low:  < 10 krads
Moderate single event effects environment
Low displacement damage environment

Low altitude/
low inclination

(HST, Shuttle, XTE)
If Short mission duration

Low altitude/
high inclination

(EOS, GLAS)
L1, L2, GEO

Medium mission duration

Examples

Europa, GTO, MEO, 
<< 1 AU

or Long mission duration
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Radiation Hardness Assurance

• Space radiation penetrates spacecraft 
shielding and interacts with components 
to produce a broad range of effects.

• A rigorous methodology is needed to 
ensure that the radiation environment 
does not compromise the functionality 
and performance of the electronics.
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Single Event Effects on Missions

• Equator-S – SE Latchup on processor & 
redundant processor

• HST – SE Transients on an optocoupler
• Terra – Single particle events on the solid 

state star tracker (SSST)
• Flight Data Recorders – SE upsets

» HST
» SAMPEX
» Seastar

• MAP – SE Transient on a voltage 
comparator
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Janet’s Top 5 Quotes About Harness Assurance

5.  “I hired radiation specialists from ACME, and I 
need you to fix their calculations for my program 
review tomorrow.”

4.  “I called to get the radiation environment for my 
mission.  I need the number now so I’ll wait while 
you look it up in your table.”

3.  “Extra overhead like radiation engineering is not 
part of our program philosophy.” (followed with 2 
weeks of 3-page emails with questions about 
radiation)

2.  “Well, my radiation plan was to add some spot 
shielding after the board is built.”

1.  “Hello, you don’t know me but I’m launching next 
week and I need you to sign these waivers.”
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NASA GSFC Missions
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Hardness Assurance Methodology

• Definition
» Activities undertaken to ensure that the 

electronic piece parts placed in the space 
system perform to their design specifications 
after exposure to the space radiation 
environment

• Goal
» A system tolerant to the radiation environment 

within the level of risk that is acceptable for 
the mission
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Typical Project Organization

40 / 70

Project 
Management

Instrument 
Systems 

Management

Observatory 
Management

ACS, I&T, 
Propulsion, 

C&DH, Comm., 
Power, 

Mechanical, 
Electrical, etc.

Ground 
Systems & 

Mission 
Operations 

Management

Safety & 
Mission 

Assurance

Mission 
Systems 

Engineering

Science Team

Radiation
Hardness
Assurance
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Hardness Assurance Methodology

• Step 1 - Describe the mission radiation 
environment and define the radiation levels within 
the spacecraft

• Step 2 - Assess the radiation sensitivity of the 
parts based on radiation databases and relevant 
radiation tests

• Step 3 – Perform Worst Case Analysis (WCA) of 
the impact of the radiation effect taking into 
account the system and circuit design

• Step 4 – Categorize parts for acceptability
• Step 5 – If needed, develop Risk Management Plan
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Spacecraft Charging – System 
Hardening

• Two distinct problems
» Surface charging
» Deep-dielectric charging

• Risk Avoidance
» Assume there will be a problem
» Evaluate with NASCAP 2K
» Follow accepted design practices

− Grounding
− Shielding
− Material selection
− Circuit design
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TID - System Hardening

• Risk avoidance
» Component selection
» Shielding strategies

− May need more accurate knowledge of component 
shielding

• Risk management
» Plan for graceful degradation
» Requires accurate knowledge of how device will 

respond in the space environment
− System criticality
− Application
− Characterization of device response

 Parametric degradation
 Enhanced low dose rate
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DDD - System Hardening

• Risk Avoidance
» Not possible for all technologies
» Protons are difficult to stop with shielding
» Hardening techniques are not effective
» Hardness changes with processing

• Risk Management
» Reduce effect with shielding
» Plan for degradation
» Knowledge of radiation environment at detector
» May require on-ground simulation
» Models are not validated – need test flights
» Mitigation through software
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SEEs – System Hardening
• Risk avoidance

» Rad-hard does not always imply SEE hard.
» Shielding is not an effective mitigator.
» System should be hard to latchup.

− Is not always possible to find replacement part
» Performance requirements push designers to use 

sensitive technologies.
• Risk management

» Typical for non-destructive events - EDAC
» Destructive - rate prediction for assessment of level of risk
» Both require accurate knowledge of how device will 

respond in the space environment
− Type of effect & system criticality
− Definition of peak & average environments
− Characterization of device response to particle hits
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Summary

• The radiation environment has complex spatial 
distribution and solar variability
» Environment definition for Project “A” will not work for 

Project “B”

• Start early in in the program – avoid retrofitting & 
redesign
» Mission concept – identify show stoppers
» Mission planning – trade studies
» Mission design – detailed analyses, quantify residual risk
» Launch & operations – manage residual risk

• Radiation hardness assurance Is a system issue –
not a component issue

• Shielding is not a “cure-all”.
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Thank you!
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Backups
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Earth’s Magnetosphere

adapted from T. W. Hill by P.H. Reiff
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Trapping Mechanisms

• Sources
» Outer zone - Solar wind & ionospheric electrons & ions
» Inner zone - Cosmic ray albedo neutron decay (CRAND)
» Trapped heavy ions - Interplanetary particles
» Others

− In situ acceleration
− Artificial, e.g. Starfish explosion

• Losses
» Collisions

− Earth’s atmosphere
− H in the exosphere
− Particles in the plasmasphere

• Stable over long periods of time
» Inner belts – Years
» Outer belts - Minutes
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TID - Compare Missions
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Space Environment Model Use in 
Spacecraft Life Cycle

Mission Concept

Mission Planning

Design

Launch

Operations

Anomaly Resolution

Space Climate
Minimize Risk

Space Weather
Manage Residual Risk

Both
+

in situ
measurements
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Pre-Launch Phases: Climatology

• Mission Concept
» Observation requirements & observation vantage points
» Development and validation of primary technologies

• Mission Planning
» Mission success criteria, e.g., data acquisition time line
» Architecture trade studies, e.g., downlink budget, 

recorder size
» Risk acceptance criteria

• Design
» Component screening, redundancy, shielding 

requirements, grounding, error detection and correction 
methods
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Launch & Post-Launch: Space 
Weather

• Launch & Operations
» Asset protection

− Shut down systems
− Avoid risky operations, such as, maneuvers, system 

reconfiguration, data download, or re-entry

• Anomaly Resolution
» Lessons learned need to be applied to all phases
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The Solar Cycle
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• Ascending Phase
» Sunspots appear
» Solar wind flow is increasingly 

perturbed by coronal mass ejections
» Atmospheric heating increases

• Solar Maximum
» Intensity and frequency of solar energetic 

particle (SEPs) events increase
» Magnetic storms associated with solar 

event activity increase

• Declining Phase
» Coronal holes expand (non-polar) 

resulting in high velocity solar wind 
streams  Recurrent magnetic storms (& 
electron storms in belts)

• Solar Minimum
» Solar wind flow not disturbed due to 

minimal SEP event occurrence
» Atmospheric heating decreases
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Planetary Atmospheres

GCRs enter atmosphere & 
collide with matter

• Secondary particles are 
produced - Important 
product is neutrons

• Earth
» Magnetic field causes a 

latitude dependence
» GCRs enter atmosphere & 

collide with O & N
• Mars

» No magnetic field – Primary 
cosmic rays are important 
component

» Thin atmosphere - Products 
from interactions with Mars 
atmosphere and surface 
materials are also important

Galactic Cosmic Rays Entering Atmosphere

Simon Swordy (U. Chicago), NASA
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Atmospheric Radiation

 1951 – Serge Korff
• Collisions between cosmic rays 

& atmospheric O & N
» Product - High energy neutrons

• 1990’s – Neutron induced 
effects in aircraft avionics & 
ground systems

• Effects
» Single Event Upsets (Low Earth 

orbits, aircraft, ground)
» Passenger & crew exposure in 

aircraft
U. J. Schrewe 

 Serge Korff
» Balloon observations, high elevations, 

rockets, high-flying aircraft
» Published study included effects of 

altitude and latitude dependence
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Solar Cycle Effects: Trapped Protons
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Boeing Neutron Model
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Solar Cycle Effects: Ground Neutrons
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Meteoroid/Orbital Debris

• Meteoroids
» Primarily remnants of comet orbits

− Several times a year  - Earth intersects a comet orbit
− Other planets

» Asteroid belt
− Daily - Sporadic particles released

• Debris
» Operational payloads, spent rockets stages, fragments 

of rockets and satellites, other hardware and ejecta
» USAF Space Command tracks over 7,000 > 10 cm 

objects in LEO
» Tens of thousands smaller objects 
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Satellite & Debris Tracking

USAF
Space Command 
NORAD Tracking 
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Micro-meteoroid & Orbital Debris 
Effects

 Damage and decompression threat
– Hypervelocity impacts from larger 

particles
– Surface erosion from collisions with 

smaller objects
 Surface effects on thermal, electrical, 

and optical properties
 Increases contamination

65 / 70

Impact into solar-cell cover glass.  Such impacts can
degrade the power producing ability of such devices

Penetrations, and commonly associated ringed 
structure, in silver-Teflon thermal blanketPenetration through an aluminized Mylar foil
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Neutral Gas/Thermosphere

• Definition
» Neutral portion of the atmosphere
» Composed of neutral gas particles
» 90 – 600 km

• Variations
» Altitude - Atomic mass

− Lower altitude – Atomic oxygen (AO) (200 - 400 km)
− Higher altitude – Hydrogen & Helium

» Heating
− Solar cycle effects due to absorption of solar extreme ultraviolet 

radiation (EUV)
− Proxy measurement with 10.7-cm radio flux (F10.7)

» Solar storms
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Neutral Gas Effects

• Degradation of surface 
materials

» Atomic oxygen in synergy 
with plasma and UV

• Spacecraft drag
• Spacecraft glow
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Plasmasphere
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Plasma Environments

• Energy < 100 keV - No radiation effects
• Ionized gas where electron and ion densities are 

approximately equal
• Sources

» Ionosphere
− Electrically charged portion of the atmosphere
− Low energy (eV)/High Density

» Plasmasphere - Magnetosphere
− Source - ionosphere and solar wind
− High energy (keV)/Low density
− Storms - Geomagnetic substorm activity

» Solar Wind
− Sun’s corona
− Seen at > 10 Billion km from the Sun by Pioneer 10
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Plasma Effects

 Surface charging – can be 
destructive

 Solar array coupling to 
plasma

– Current drain
 Contamination

– Dense pressure of 
atmosphere in LEO

 Generation and emission of 
plasma waves

NASCAP2K

70 / 70


	Space Environments & Effects
	Acronyms
	Outline
	Space Environments
	Space Environments & Effects
	Definitions
	Units
	High Energy Radiation
	Characteristics of the Radiation Environment
	Surface Charging
	Deep Dielectric Charging
	Displacement Damage Dose (DDD)
	Total Ionizing Dose (TID)
	Single Event Effects (SEEs)
	Solar Activity Cycle
	Interplanetary Particles – Galactic Cosmic Ray Heavy Ions (GCRs)
	GCRs:  Nuclear Composition
	Solar Cycle Effects: Heavy Ions
	Slide Number 19
	Interplanetary Particles – Solar Energetic Particles (SEPs)
	Solar Cycle Effects: Solar Protons
	SEPs: Proton Event Spectra
	SEPs: Shielded Fluences
	Trapped Particles
	Trapped Particle Motions
	Trapped Radiation Belts
	Trapped Protons
	Slide Number 28
	Trapped Electrons
	Slide Number 30
	Effect of Solar Storms on Trapped Protons – CRRES Measurements
	Effect of Solar Storms on Trapped Electrons – SAMPEX Measurements
	Single Event Upsets on Seastar Solid State Recorder
	Radiation Environment Levels
	Radiation Hardness Assurance
	Single Event Effects on Missions
	Janet’s Top 5 Quotes About Harness Assurance
	NASA GSFC Missions
	Hardness Assurance Methodology
	Typical Project Organization
	Hardness Assurance Methodology
	Spacecraft Charging – System Hardening
	TID - System Hardening
	DDD - System Hardening
	SEEs – System Hardening
	Summary
	References
	Thank you!
	Backups
	Earth’s Magnetosphere
	Trapping Mechanisms
	TID - Compare Missions
	Space Environment Model Use in Spacecraft Life Cycle
	Pre-Launch Phases: Climatology
	Launch & Post-Launch: Space Weather
	The Solar Cycle
	Planetary Atmospheres
	Atmospheric Radiation
	Neutron Flux Measurements
	Solar Cycle Effects: Trapped Protons
	Boeing Neutron Model
	Solar Cycle Effects: Ground Neutrons
	Meteoroid/Orbital Debris
	Satellite & Debris Tracking
	Micro-meteoroid & Orbital Debris Effects
	Neutral Gas/Thermosphere
	Neutral Gas Effects
	Plasmasphere
	Plasma Environments
	Plasma Effects

